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Abstract— The graphical user interface (GUI) to
heterogeneous neural network simulators proposed
in this article is intended to be of use both for the
novice and for the experienced neural network user.
For the novice, it provides an easy to use neural
network simulation package that insulates the user
from the need of knowing the simulator implemen-
tation details or the configuration file syntax. For
the experienced neural network professional it pro-
vides an interface that is easily extensible to include
any additional neural network simulator in its bi-
nary form. To satisfy both academic and personal
computer environments, the GUI has been devel-
oped by using the free TCL/TK software package,
available both on workstations running UNIX and
on PC’s running the free Linux operating system.
Although the GUI and the embedded simulators
have been successfully tested both in neural net-
work research and training programs, a more ex-
tensive testing in undergraduate and graduate level
classes is in progress.

I. INTRODUCTION

Neural network technology has the potential to solve an
impressive variety of today’s technological problems which
conventional computers are quite powerless to deal with
[5]. Popularity of this technology is rapidly growing since
it proved its applicability in everyday applications as di-
verse as signature verification [2], power consumption pre-
dictions [14], or financial markets forecasting [4].

Neural network data modelling techniques are applicable
to two general types of problems:

e (lassification problems, in which the goal is to classify
a number of patterns as belonging to different cate-
gories (an example would be to automatically recog-
nize hand written zip codes and classify each symbol in
one of ten categories corresponding to the digits from
0 to 9 [15]).

e Prediction problems, in which the goal is to predict
a future value of a specific process parameter (an ex-
ample would be the prediction of the U.S. power con-

! Sponsored in part by the NSF research grant NSF-IRI-9308523 and
by the NSF education grant NSF-ESI-9254358.

sumption for the year 1997). The prediction problems
can be regarded as limit cases of classification prob-
lems in which the number of classes is infinite.

In addition, these techniques are applicable not only to
time independent, but also to time dependent problems
(time series), where the patterns to be classified are tem-
poral sequences of previous process values.

Neural network computational models consist of a num-
ber of relatively simple, interconnected processing units
called neurons working in parallel. Different neural net-
work architectures can be used to solve a given classifica-
tion or prediction problem. In an architecture the neurons
are interconnected through synaptic links and are grouped
in layers, with synaptic links usually connecting neurons
in adjacent layers. Typically three different layer types
can be distinguished: input layer (the layer that external
stimuli are applied to), output layer (the layer that out-
puts results to the exterior world) and one or more hidden
layers (intermediate computational layers between input
and output layer). The neural network architectures can
be, roughly speaking, divided in two categories: feedfor-
ward, in which the signal flow between different layers is
unidirectional (from input layer towards output layer), or
recurrent, in which the flow between different layers is bidi-
rectional (both from input layer towards output layer as
well as opposite).

The most distinctive element in neural networks, as op-
posed to traditional computational structures, is denoted
as learning. Learning represents the adaptation of some
characteristic neural network parameters by using a set of
examples (known outcomes of the problem for given condi-
tions) so that for given input patterns the outputs reflect
the value of a specific function. The final data modelling
goal is not to memorize some known patterns, but to be
able to generalize from prior examples (to be able to esti-
mate the outcomes of the problem under unknown condi-
tions).

Neural network data modeling represents the combina-
tion of an architecture and an appropriate learning tech-
nique. Traditional approaches assume learning on a pre-
specified architecture, whereas constructive learning cre-
ates the appropriate architecture during the learning pro-
cess. Most neural networks have a number of architec-
tural and learning parameters that have to be appropri-



ately specified. Selection of appropriate parameters for
large scale applications is an important experimental prob-
lem. If parameters are not appropriate, the algorithms may
take a long time to converge or may not converge at all [21].
Consequently, in training novice neural networks users, an
emphasis on techniques and intuition development is nec-
essary for properly setting these parameters.

Currently, most neural networks modeling is performed
on standard sequential computers (rather than on special-
ized neural networks hardware) using simulation software.
Until recently the choice of a simulation software was not
a primary issue among neural network professionals, as ap-
plications of neural networks technology have been limited
to relatively small problems. However, the choice of an
efficient simulation software plays an important role when
dealing with large scale, real life applications as desired by
industry. The approach proposed in this paper provides de-
velopers with a number of simulator modules implementing
various learning algorithms, all using a single user interface.
In such an environment it is easier to select the model that
is appropriate for a particular application than to become
accustomed to various independent simulators.

Until recently, most neural network modeling work was
performed by highly trained neural networks experts. In
practice, such experts learn how to use several commercial
or freely available packages and in addition develop their
own software to deal with special issues not supported by
the packages. Experience seems to indicate that for deal-
ing with features not supported by the standard packages,
even inside a single group, most neural networks experts
prefer building their own software rather than using code
developed by other experts, as it usually takes a significant
time to learn how to use somebody else’s neural networks
code properly. We strongly believe that the software reuse
among experts can be significantly improved by using a
flexible user interface, as proposed in this paper, that can
easily support developers’ needs.

As the applicability of artificial neural networks seems
to extend far beyond the computer science domain to ar-
eas like electrical engineering, biology, medicine, business,
the need for rapidly trained personnel able to quickly as-
similate neural network techniques and to apply them to
the corresponding domain becomes more and more acute.
Thus the necessity to acquire some basic neural network
knowledge rapidly, without covering underlying mathemat-
ical and programing details, but rather concentrating on
understanding the conceptual model as well as on design-
ing adequate experiments tuned to a particular problem.
Our experience indicates that the choice of a graphical user
interface, as proposed in this paper, plays a crucial role
when trying to transfer neural network technology rapidly
to non-expert users.

The graphical user interface (GUI) proposed in this arti-
cle is intended to be of use both for the novice and for the
experienced user. The software package included with this
paper provides an interface to both the most used tradi-
tional backpropagation learning through gradient descent

optimization on a prespecified analog architecture [17] and
to a novel learning technique developed in our lab, known
as hyperplane determination from examples (HDE), that
automatically grows a problem tailored discrete architec-
ture [10, 11]. The fine-tuning of each neural network learn-
ing process is done by adjusting specific learning param-
eters. For the novice, it provides an easy to use neural
network simulation package supporting both backpropaga-
tion, as well as HDE, that insulates the user from the need
of knowing the implementation details, as well as the con-
figuration file syntax for running the simulators. For the
experienced neural network professional it provides an in-
terface that is easily extensible to include any additional
neural network simulator in its binary form.

The paper is organized as follows: Section 2 contains a
description of the graphical user interface and its under-
lying menu structure; Section 3 illustrates the flexibility,
portability and extendibility of the GUI by means of em-
bedding two radically different neural network simulators;
finally, Section 4 discusses the applications of the GUI in
research and teaching, as well as suggestions for further
improvements of the GUIL.

II. GUI DESIGN AND IMPLEMENTATION

The objective of our effort was to develop a portable GUI
that would be able to serve neural network professionals,
as well as a large number of novice neural network users,
who might have access only to personal computers (PCs).
With the introduction of Linux, a free UNIX-like operating
system that runs on Intel 386/486/Pentium based personal
computers (PCs), the use of UNIX and X Window environ-
ments becomes affordable not only to institutions, but also
to the large PC users community [1]. Linux provides the
PC user with the power and flexibility of the UNIX oper-
ating system, as well as with an overwhelming amount of
free, good quality software. One of the software packages,
included in most of the Linux distributions, available also
on UNIX workstations in academic environments, is Dr.
John Ousterhout’s TCL/TK package [16]. TCL, standing
for “tool command language” is a general purpose script-
ing language for controlling and extending applications,
whereas TK is a toolkit designed to develop X Window
applications. For those who aren’t familiar with X Win-
dows, this represents a windowing environment, similar in
appearance to PC window environments, that is used in the
UNIX environment. Both TCL and TK are implemented
as libraries of C procedures that allow the extension of their
core features. In its actual form, TCL is interpreted, thus
suggesting that there might be a slowdown as compared
to a compiled program. This potential slowdown isn’t ap-
parent for scripts of a few thousand lines, as is sufficient
for developing a GUI for neural network simulation. The
CD-ROM software accompanying this paper includes the
GUI and simulators’ executable files for both HP 9000 se-
ries workstations, as well as for PC’s running Linux. To
run the included software on one of these platforms, the
existence of TCL ver. 7.3 and TK ver. 3.6 is also required.



(3 BUI for Newral Network Simulator

File Network Configuration

5

Run View Color Help

GUI for Neural Network Simulators Ver.1.2 (by Radu Drossu - 1995)

Figure 1: GUI Main Window

The GUI proposed in this paper is developed for UNIX
and Linux environments, to satisfy both expert and novel
users’ needs. For ensuring portability, the GUI has been
written using just the TCL/TK core features without any
additional C procedures. The GUI allows an interactive
setting of neural network simulator parameters as well as
the execution of the simulations. In its current form, the
GUI embeds two radically different simulators, a backprop-
agation simulator and the HDE constructive learning sim-
ulator. A basic understanding of TCL/TK should allow
the user to easily embed additional simulators by ”linking”
their executable files to the GUI interface.

The GUI provides the following basic features:

1. A basic text editor for editing plain text files.

2. The color configuration of all the GUI items.

3. Setting the characteristic features and parameters for
the underlying neural network simulators.

4. Saving the neural network configuration in the simula-
tor specific file formats, as well as retrieving a neural
network configuration from a file in the case of the
backpropagation simulator.

5. Viewing the neural network configuration both in a
tutorial style form (in which the significance of the
different configuration options is briefly explained), as
well as in the format in which the configuration would
appear in the simulators’ configuration files.

6. Running the simulators both as foreground and as
background processes (for an explanation of foreground
and background processes, the reader can consult 19,
22)).

7. A help file that provides information on running the
simulators both by using the GUI, as well as by edit-
ing the corresponding configuration files for the simu-
lators.

In order to run the GUI, the contents of either the di-

rectory called NNGUI/UNIX (for HP 9000 series worksta-
tions), or of NNGUI/LINUX (for PC’s running Linux) from
the CD-ROM needs to be copied to a user’s directory, say
MYNNGUI. The current directory needs to be changed to
MYNNGUI and the GUI can then be started by issuing the
command nngui. The GUI main window is then displayed,
as shown in Fig. 1. The different menus can be accessed ei-
ther by clicking them with the left mouse button or keeping
the ALT key pressed while pressing the underlined letter
of the menu name. During application execution, certain
GUI options can be accessed directly from the main win-
dow through the use of a keyboard accelerator (hot key).
The options that have corresponding hot keys have the key
combination displayed in the pop-up menus (read also the
help file for a list of options), where CTRL+A stands for
“press the CTRL key and keep it pressed while pressing
the A key ”(the GUI is not case sensitive, so lowercase ¢ is
the same as uppercase 4). In each file selection box, a file
is selected by double-clicking it with the left mouse button.

The menu structure of the GUI can be represented hier-
archically as in Fig. 2.

A brief explanation of each of the different menu items
supported under the current GUI implementation follows.
For a more detailed explanation, install the program from
the CD-ROM and select the Help option under the Help
menu item, or press CTRL+H in the main menu window.

A. The File Menu
The following file access options are included in this menu.

e The Edit File menu item provides access to a simple
general purpose text editor, that allows the GUI user
to easily change parameters in a previously used neural
network configuration file. A file selection box allows
the user to select either an existing or a new file to edit
(see Fig. 3). An editor window is then displayed, hav-
ing the basic editor commands printed at the bottom
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Figure 2: GUI Menu Structure

of the screen (see Fig. 4).

e The Load Config menu item allows the loading of a
previously saved configuration file. It also allows the
more advanced user to load a configuration file that
was created directly (without the use of the GUI). In
its current implementation, the GUI supports this op-
tion just for the backpropagation simulator.

e The Save Config menu item allows the saving of the
neural network configuration defined in the GUI to
a file. This allows the user to save a certain neural
network configuration for future use.

e The Ezit Program menu item exits the application.

B. The Network Menu

This menu allows the selection of the desired simulator.
The current version of the GUI supports two different neu-
ral network models:

e The Backpropagation menu item selects the backprop-
agation simulator. By selecting this option, the set-
tings specific to the backpropagation simulator will be
displayed under the Configuration menu.

e The Constructive HDE menu item selects the HDE
constructive learning simulator. This option will also
enable the display of constructive learning specific set-
tings under the Configuration menu.

C. The Configuration Menu

Parameters specific to the supported neural network mod-
els are set by using this menu. This menu is neural network
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Figure 3: File Selection Box

model sensitive, meaning that the characteristics displayed
depend on the simulator set in the Network menu. A more
detailed description of this menu in the current GUI im-
plementation is given in Section 3.
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Figure 4: Edit File

D. The Run Menu

The Run menu starts the selected neural network simula-
tor. It consists of three menu items:

e Run from File starts the simulator using a simula-
tor specific configuration file. This is the option that
an expert in a particular neural network model would
most likely use.

e Run from Desktop starts the simulator using the pa-
rameters that have been configured by using the GUI.
This is the preferred option for a novice user, who is
unfamiliar with a particular neural network simulator.

e Options allows the choice of whether to run the simu-
lator as a foreground or as a background job (in which
case the output of the simulation will be redirected
to a file). The foreground option is usually preferred
in the case of a short simulation run (of the order of
minutes), whereas the background option is used in
the case of long simulation runs (that last hours or
even days).

FE. The View Menu

This menu allows the display of the current simulator set-
tings.

o View Params displays the settings in a fairly self ex-
planatory way, thus helping the user to decide whether
all the settings are appropriate or not.

o View File displays the settings in a more cryptic way,
characteristic to the specific configuration file syntax
of the underlying simulators.

F. The Color Menu

For a more pleasant appearance of the GUI, a multitude
of color options can be set in this menu. The Color Mode
menu item allows the selection of colors in three different
ways, either by using X Windows’ default names, or by
using two more sophisticated, but fine tunable, color selec-
tion techniques, HSV and RGB [9]. A setup screen for an
HSV color selection is shown in Fig. 5.

The default color configuration can be restored by select-
ing the Restore Color Configuration menu item, whereas
the preferred color configuration can be saved by choosing
the Save Color Configuration menu item. Whenever a new
color configuration is saved, it will overwrite the previously
saved color configuration stored in the file config.crt.

G. The Help Menu

This menu contains a release number of the current GUI
version under the About the GUI menu item, as well as a
help file under Help.

III. THE CONFIGURATION MENU AS A KEY TO
EMBEDDING HETEROGENEOUS NEURAL NETWORK
SIMULATORS

The two neural network simulators embedded in the cur-
rent GUI are drastically different in implementation. The
backpropagation simulator represents a traditional learning
technique applied to a fixed architecture, whereas the HDE
constructive learning simulator updates the architecture
during the learning process. Implementation-wise also, the
two simulators are also radically different. Although both
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of them were programmed in C, the HDE simulator also
uses XLib calls to implement a graphical visualization of
the learning process. In addition, whereas the backprop-
agation simulator is intended to be run only sequentially
(on a single sequential computer), the HDE simulator can
be run both sequentially or in parallel, either on a highly
parallel machine, such as the Paragon at the San Diego Su-
percomputer Center [18], or in a local distributed system (a
computer network). Effective support of two so different
neural network models by a single GUI is a strong indi-
cation that the GUI is flezible. In addition, as long as a
compiled (binary) version of the simulators is available on
a certain computer that has the TCL/TK (ver. 7.3/3.6)
package installed, the GUI can be successfully used, thus
showing that the GUI is portable. Finally, when additional
neural network simulators need to be embedded in the GUI,
this can be accomplished without significant effort, as long
as the binary files of the simulators are available, proving
that the GUI is also eztensible.

From the perspective of the end user, who should be
insulated from implementation details, the only differences
that appear between various simulators are reflected just in
the Configuration menu. As mentioned before, this menu
depends on the neural network simulator selected in the
Network menu. If additional simulators are added to the
GUI, these will be reflected in the corresponding Configu-
ration menu options when selected.

A Dbrief description of the configuration options for the
two neural network simulators included in this version of
the GUI follows. For a detailed description of the param-
eters that are set in this menu, the reader is advised to
install the software from the CD-ROM and to consult the
help file (by pressing CTRL+H in the main window). For
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Figure 6: Setting the Activation Function for the Back-
propagation Simulator

configuring model parameters, basic concepts for the back-
propagation learning technique can be found in [12, 13],
whereas for the HDE constructive learning in [10, 11].

The corresponding Configuration menu settings for the
backpropagation simulator are:

o Architecture allows to select either a feedforward or a
recurrent neural network, as well as to establish the
desired layer structure (number of layers and number
of neurons per layer). In the case of recurrent networks
it also allows the selection of the feedback type and of
the feedback layer, as well as of the scaling parameters
for the feedback signals.

e Parameters sets the backpropagation specific learning
parameters, known as learning rate, momentum and
tolerance.

e Activation allows the setting of the neurons’ activation
function to either a sigmoidal, a hyperbolic tangent or
an identity function. The setting can be done either
globally (for all the neurons in the network) or locally,
either at layer level or at neuron (unit) level. An actual
screen of the activation function window is presented
in Fig. 6.

e Update Mode sets one of the two specific modes in
which the weights of the synaptic links are updated,
either continuously (after each training example) or in
batch mode (after each presentation of all examples
from the training set).

o Initial Weights allows to set the initial value of the
synaptic links’ weights either randomly, or with values
read from a file.

o Set Weights allows the setting of particular weight val-
ues either globally (for all the synaptic links), or locally
(for all the links connecting two adjacent layers, for all
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Figure 7: Setting the Parameters for the HDE Simulator

the links emanating from a given unit, for all the links
ending at a given unit, or for a single link).

Enable Wezights allows the enabling or disabling of cer-
tain synaptic links in ways similar to setting weight
values. A disabled link behaves like a disconnected
link.

Horizon allows to set the desired testing horizon for
time series prediction problems (a testing horizon of
one indicates the prediction of just the next process
value, whereas a prediction horizon larger than one
indicates the prediction of a process value further in
future). This menu item also allows the setting of the
training horizon, an internal learning parameter that
can’t exceed the testing horizon.

Threshold allows a brute force elimination of training
examples with outputs above or below a certain level
(None stands for no elimination of training examples).
Training selects the training file (file containing all the
examples used during the learning process), as well as
the number of training epochs (number of repetitive
passes through the example file) and the number of
epochs after which to display the learning status.
Testing selects the testing file (file containing examples
not seen during the learning process, on which to test

the generalization ability of the neural network).
Generating allows the generation of a time series.

The Configuration menu settings for the HDE construc-
tive learning simulator are:

Inputs allows to set the number of neural network in-
puts (the number of outputs is one, since the simulator
is used just for binary classification problems).
Parameters allows the setting of HDE characteristic
parameters like learning rate, random seed, tolerance,
classification improvement threshold, maximum itera-
tions for output layer, maximum iteration for hyper-
plane selection, maximum number of boundary points,
maximum number of example pairs. The parameters
setting screen is shown in Fig. 7.

Training and Testing allow the setting of training and
testing files, similar to the case of the backpropagation
simulator.

Graphics Modes allows the setting of the graphic dis-
play modes for tracing the constructive learning pro-
These include the display of training and test
patterns, interpolation steps, points on separating hy-

CEss.

perplanes, candidate and actual hyperplanes, as well
as the final separating surface. An actual graphics
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screen resulting from a simulation in which all the
graphics options, except the display of the test pat-
terns are set, is presented in Fig. 8.

e Network Switches allows the setting of different addi-
tional HDE options such as creating hidden units and
printing the network, the training and the test sets.

o Advanced Options allows the selection of two sophis-
ticated features. The Hybrid System option incorpo-
rates prior knowledge to the HDE learning, provided
in the form of an expert system [10]. The Parallel
Computation option allows the parallel execution of
the simulation on either a distributed system or on
a highly parallel machine [11]. This also implies the
existence of the p4 software package on the user’s com-
puter, which might not be installed on all systems, al-
though it is available cost free from Argonne National

Labs [3].
IV. APPLICATION IN RESEARCH AND TEACHING

The primary goal of the GUI development was to assist
both neural network professionals and novel users in per-
forming neural network experimentations on heterogeneous
simulators.

From the professionals’ perspective, the two embedded
neural network simulators were successfully used either di-
rectly or by means of the GUI in our lab for several research
projects, covering various problems [6, 7, 8, 10, 11].

In summer 1995, the GUI was also used by neural net-
work first time users during the WSU/NSF Teacher In-
stitute for Science/Mathematics Education through Engi-
neering Experiences training program. Two mathematics
teachers who had no prior knowledge of both the UNIX op-
erating system and neural networks spent 6 weeks in our

lab with the objective of learning neural network techniques
for designing backpropagation experiments. After getting
accustomed with the GUI in a fast learning process, the
results obtained by them on a few neural network bench-
mark classification problems like the Monk problems [20]
and the breast cancer diagnosis problem [23] were com-
parable to the best known results for the corresponding
problems. As a final result, they also developed a neural
network teaching module to be used in high school.

Although the GUI and the embedded simulators have
been successfully tested both in neural network research
and training programs, a more extensive in class testing is
needed. Hence, the GUI is intended for use in two courses
offered in Fall '95 at the School of Electrical Engineer-
ing and Computer Science at Washington State University.
One is an undergraduate course on Artificial Intelligence,
whereas the other one is a graduate course on Neural Net-
works. From these two diverse groups of students we ex-
pect to gain valuable suggestions on future extensions to
the current version of the GUI. Finally, any feedback from
the readers of this article and users of the software pro-
vided on the accompanying CD-ROM would be extremely
beneficial for improving the current GUI implementation
and embedding additional neural network simulators.
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